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Fabrication Profiles: How Do You Manage Your
Database Without Them?
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Kevin Allen
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Learning Objectives

e Understanding the benefits of using Profiles for both Fabrication Products and
REVIT

e Cover what parts of the database are Global vs. Profile specific

e Learn to create and manage Profiles for use in Fabrication Products as well as
REVIT

e Learn how to edit the Profile for Project requirements for use in Fabrication
Products as well as REVIT

Description

Does your company have multiple locations, branches or divisions? Does your Fabrication
Database have multiple “Job Specific” Services? Does your Fabrication Database have multiple
“Job Specific” Pressure Classes, Insulation Specifications or Support Specifications? If you
answered “Yes” to one of these questions, we have a solution for you. Using Autodesk
Fabrication Profiles for each project is a great way to maintain the Autodesk Fabrication
Database without the need for Project Specific Groups within the database. Utilizing Profiles will
help maintain a clean database to eliminate temporary database entries. If you plan to use
Fabrication Parts in Revit, this is a Must See.

Your AU Experts

William Tucker

William is currently working at Comfort Systems USA, a Premier Mechanical Systems
Installation and Service provider, as BIM Trainer and Product Specialist. CSUSA is a national
organization with 24 companies, 7 Sheet Metal Fabrication Shops and 190 users currently
sharing the Autodesk Fabrication Products with one database. William is responsible for
implementing, training, and advising on best practices for these companies, developing
standards within the organization, and providing technology recommendations for the future. In
the past, William has trained and Implemented Autodesk Fabrication CADmep, ESTmep, and
CAMduct as well as utilized it as a 3D detailing and coordination package. William has been
using Autodesk Products for 29 years. William enjoys helping others utilize the software to its
fullest extent.
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Kevin Allen

Kevin is currently employed at Comfort Systems USA, a Premier Mechanical Systems
Installation, and Service provider with annual revenue of $1.6B, as Director of BIM and
Productivity. CSUSA is a national organization with over 7K employees and 36 operating
companies, with some being service only. Currently, 24 of these locations utilize Virtual
Design/Construction, with 7 Sheet Metal Fabrication Shops, numerous pipe and plumbing
shops, with 190 employees utilizing the Autodesk Fabrication Suite of Products on ONE
database. Kevin is responsible for implementing, training, and advising on best practices for
these companies, developing standards within the organization, and providing technology
recommendations for the future, along with numerous other tasks. In the past, Kevin has
trained Autodesk Fabrication CADmep, as well as utilized it as a 3D detailing and coordination
package. Kevin enjoys helping others utilize the software to its fullest extent.

A little history of my experience with Profiles.

I have worked with the Autodesk Fabrication Software for 12 years and | have trained and
worked with implementation on the software for the past 10 years. | will have to admit that | may
have been the person that started the “Project Specific” services, service templates and
specifications. Several years ago MAP software had introduced “Profiles” and had asked me to
test them. Well, | was out helping with an implementation of a well-experienced client that
wanted to rebuild their database. After analyzing what they wanted to do | thought that Project
Specific Profiles would be the answer, so | suggested that we test them and they agreed. We
spent 3 days building new services and service templates, so now we were ready to test
Profiles. Within about 10 minutes of testing we lost every service and service template, yes we
lost them, but luckily for us, | had exported them prior to testing. Needless to say, that was the
end of my testing for a few more years.

In 2012 after Autodesk acquired MAP Software, Andy asked me to test them again and
assured me that would not have that same issue again. | started testing the again in my spare
time and could not reproduce the Issue again, but | had never tested them on a live database.

I hired on with Comfort Systems USA in September of 2013 and the main goal was to help
Kevin Allen and Josh Asche build a national database that could be used across the country
with all of the OpCo’s (Operating Companies). Well at that point the only way we could see this
to be possible was the use of “Project Specific Profiles” and “Sharing The Database via the
Cloud” (MSF21480).

We did some extensive testing with Profiles ourselves and could not break them. We then call
about 14 of our employees across the country to meet in one location for a week. We used all of
them to help test and we developed some tasks for everyone to execute at the same time to see
if we could break it, we could not break it and had 100% success on all tasks. We rolled out our

National database in January of 2014 and have had tremendous success using Profiles. But
there are a few rules to follow....
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Understanding the benefits of using Profiles for both Fabrication Products
and REVIT

What Are Profiles?
Profiles are mini databases within one, kind of like an ESJ file.

The Global Profile is your main Profile(database) and this should be treated as a template.
Create project specific profiles from the Global Profile and create a new Profile for every project.

Benefits:

The benefits of using Profiles far outweigh the cons

1. | can say that the main benefit is that using Profiles will keep your main database
(Global) very clean
a. Over the years of working with other companies, | have helped a lot of them
rebuild their database so many times due to a lot of clutter/temporary data that
has been into their database.
2. In your Global Profile you will not need Job specific;
a. Services
b. Service templates
c. Sheet metal specifications
d. Support specifications
e. Insulation specifications
3. When working on a project the user will not need to choose from hundreds of services to
determine which one to use for that project while working in the Fabrication products or
REVIT.
4. When you need project specific service templates or specs, just modify the existing ones
in the Project Profile, no need to copy, rename and reassign.
5. When a Profile is created most database settings are static at that point in time.
6. You can add your button mappings needed for REVIT accessories without needing to
add them to the Global database. See FAB Parts in REVIT: Understanding how Design
to Fabrication works in REVIT (MSF21097)

Cons:

1. When a Profile is created most database settings are static at that point in time.
a. Database information can be exported from Global and imported into the profile if
needed.
b. Sheet Metal material pricing can be cumbersome

MSF21096
Page 3


https://events.au.autodesk.com/connect/sessionDetail.ww?SESSION_ID=21097

M AUTODESK UNIVERSITY

What parts of the database are Global Versus Profile specific?

Like I had said Profiles are just mini-databases. For those that understand the Fabrication
database, you may want to know what database files are Global and what files are Profile

specific.

This is a list of Common Files and Uncommon Files between Global database and the Profile

database

Global_File GlobExt

address
Airturn
ANCILLRY
BarCode
COLOURS
Connectr
Cost
Cutouts
DAMPER
Diameter
dwgdb
EDGENEST
ETimes
FACINGS
FTimes
HSpecs
ISpecs
jobb
layers
LEADS
Material
MCGROUPS
NESTING
Notches
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Profile_File

Airturn
ANCILLRY

Connectr
Cost
Cutouts
DAMPER
Diameter
dwgdb

ETimes
FACINGS
FTimes
HSpecs
ISpecs

layers
LEADS
Material

NESTING
Notches

map
map

map
map
map
map
map
map

map
map
map
map
map

map
map
map

map
map
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Notes
oglQTOdetail
OPENGL
PARTNAME
pmdetail
Process
prodinfo
QDETAIL
RESISTANCE
RESISTLINK
Seam
sections
Service
SETUP
Silencer
Specs
splitter
STIFFNER
StressLd
SUPPLIER
SUPPORT
TAKEOFF
TEXTATTS
TOOLDFLT
All Machines
Machine
buttons
products
scribe
IMPORT
PROFILE
SOLIDART
SOLIDSHAPES
toolbase
Backup
DECOILER
Users
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mch
cfg
dat
dat
fnt
R2V
R2V
R2V
R2V
txt

Notes

PARTNAME

RESISTANCE
RESISTLINK
Seam
sections
service
SETUP
Silencer
Specs
splitter
STIFFNER
StressLd
SUPPLIER
SUPPORT
TAKEOFF
TEXTATTS
TOOLDFLT
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The parts of the database that should be the most commonly changed after a Profile is created
are;

Service Template to possible replace Piping of duct accessories

Hanger specifications (values only, not names)

Insulation specifications (values only, not names)

Sheet Metal specifications (values only, not names)

Sections

Default Machine (for Multiple shop locations)

ouprwONE

Create and managing Profiles for use in Fabrication Products as well as
REVIT

To create a profile with CAMduct and ESTmep go to File>Profiles>setup

Eile lutilities Cloud Takeoff View Window Add-Ins Help

@ New Job B a 1

L

& Open Job Job Jo
Close Job .

Close Job Information Cont

* Purge Jobs...

Browse For Jobs...

o D P BB

Profiles > Setup...
Import 3 Import
Export 4 Export Repeat TAKEOFF
. . . . Recent Input > Edit
To create a Profile with CADmep Right click on R "I
the screen go to CADmep>Profiles>setup Isolate Objects > Hide Attacher
Basic Modify Tools > Re-Number
Clipboard > Change Spedification(s)
AEC Modify Tools > Update Dynamic Holes

B Select Component T80 vy

[ Object Viewer. Job Information

Cost Breakdown

¥ Pan
% Zoom Print
& 3D Orbit Print Preview
©) SteeringWheels Print Layout >
B Properties Ctrl+1 Printer Setup
Reports
Cam

Output to Viewer
Update Viewer Output

Output Points

Load Points
Setup
Profiles >

Setup
Utilities >

Import
Import > Bt
Help

MSF21096
Page 6



M AUTODESK UNIVERSITY

Start with Global

Click the Green Button to Create a new Profile
Name Your Profile

Select Copy Basic Database Only

Check the box for Share the same Item Files
Check the box for Selected Sections

Select the sections that you want to copy for your
project

Select “OK” for sections

Check the box for Selected Services

Select the Services that you want to copy for your
project

10. Click “OK” for services

11. Click “OK” to accept the Profile

ourwNE

© o N

Profiles - Active : Globa bt

Current | Global ~

Switch Close

Name‘Samp\e Profile |

Path C:/Dropbox (Comfort Systems USA)/| | 4
Copy From Active Profile "Global”

(O Copy Nothing / Create Blank Profile
(®) Copy Basic Database Only

Share the Same Item Files
+ Selected Sections
+ Selected Services

() Copy Al

Separate Database

Shared Item Files .

OK Cancel

Copy Services X

D= Galvanized ~
OEA (Twg)
FIEA (2wg)
COA (1wg)
F0A (2wg) 12.

ORA (1wg) .
RA (2wg)

CIRAMP (10wg)
CIRAMP (3wg)

CIRAMP (6wg)
OREL (1wg)

CIRAMP (4wg) Profiles - Active : Globa

OIREL (2wg) Current | Sample Profile

CISALP (Twg)
A QAL P (wny
>

<
. ‘ OK Cancel
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Switch

NamE|Samp\e Profile .

Path|G-/Dropbox (Comfort Systems USA)A | g4

Copy From Active Profile "Global"

(") Copy Nothing / Create Blank P
(®) Copy Basic Database Only

Share the Same Item Files .

+ Selected Sections
[ ]+ Selected Senvices
() Copy Al

Separate Database
Shared ltem Files

Copy Sections

cel

| | AFAB Default .
Level 0 UG

Level 1
Level 10
Level 11
Level 12
Level 13
Level 14
Level 15
Level 16
Level 17
Level 18
Level 19
Level 2
Level 20
Level 3

Ol Cancel

X

MIENEES

Switch | Close

Click Close to close the profile setup or switch to
change to the new profile.
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Managing Profiles

Rules
Yes, you have a few rules to follow;
Do not try to work on multiple drawings with more than one profile in the same session of

1.

2.

AutoCAD. (This can cause the Profile to become corrupted)

If you need to work on two drawings with different Profiles use a separate session of
AutoCAD for each profile.

Never work out of the Global profile, this is only for setup, testing and creating Profiles
from. Actually, this should be a rule for every Fabrication Database Never work on a
drawing logged in as Full/Admin.

In AutoCAD, always load the Fabrication application before opening a drawing.

Never double click on a drawing in windows explorer to open a drawing.

Changing Profiles

In AutoCAD, you can tell what Profile that you currently have loaded on the title bar

Tools

Powered by Fabrication CADmep 2017 - Config "AU-2016" - Profile "FABIT AU-2016" [AutoCAD MEP (US Imperial)]  Drawing1.dwg

50 Raste nce  CSUSA

[ 1]
® Duct Fitting ~ M Pipe ~ o - v X v - % Section Line
M Vertical Detail

@ fquipment = ™) Pipefitting ~ - W - - J v ' .’ " Section @ Elevation Line Components

& Duct ~ g * v )" v ¥ Y . ntal Section -

Build Draw Modify ¥ Layers Annc on Elevation ¥ Details

In CAMduct or ESTmep you can tell what Profile that you currently have loaded on the title bar

. cAMduct 2017 (Untitled3) - Config "AU-2016" - Profile "FABIT AU-2016" - User “cam” *NOT FOR RESALE* - [Quick Takeoff]

§§E File Utilities Cloud Takeoff View Window Add-In

i [T n Q
B = G CEE EL @
Job Browser Save Job Close Job . Job Iltem Folders Quick Setup Au
ormation Contents Takeoff Processes \
MSF21096
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If you have the wrong profile loaded, when you open a drawing you will get a warning.
“This Drawing uses “XYZ” Profile” Switch Profiles now?

In this case, click “Yes”

NEVER check the box “Don’t Show Me This Again”

Warning X

&) This file uses profile "Sample Profile"
12

Switch Profiles now?

[ ] Don't Show This Message Again

e | e

If you start working on a drawing using with the wrong Profile loaded.
1. Save and Close the drawing.
2. Close AutoCAD
3. Open AutoCAD
4. Change Profiles to the Profile that you should have been using.
5. Open the drawing.

You will get a warning.

“This Drawing uses “XYZ” Profile” Switch Profiles now?

In this case, click “No”

NEVER check the box “Don’t Show Me This Again”

Warning XK

&) This file uses profile "Sample Profile”
o

Switch Profiles now?

[ ] Don't Show This Message Again

veo [ Wa |

When you save the drawing. The Profile will now be associated to that Drawing.

MSF21096
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Edit the Profile for Project requirements for use in the Fabrication Products
as well as REVIT

When you are in your Profile you should now have just a small list of services to select from.
This can be handy for the CAD detailers and REVIT users so that they don’t have a large
selection to choose from.

B D> Galvanized

EA (2wg)

OA (2wg)

RA (2wg)

SALP (2wg)

SAMP (4wg)

8 MP>CU-L-SWT (2) CS-A53-ERW-GrB-STD-BW
CHWR

CHWS

CWR

CWS

HHWR

HHWS

PCWR

PCWS

8 P_DOM>CU-L-SWT
cD

DCwW

DHW

DHW-140

DHWR

DHWR-140

RGW

TP

8 P_DWV>PVC-Sch40-SW (Charlotte)

GW

oD

SD

SDBG

SSAG

SSBG

SSD

VNT

o ]
None b2

You do only get these selected services and sections to choose from, but you get all of your;

1. Service templates

2. Hanger specifications

3. Insulation specifications
4. Sheet Metal specifications
5. Stiffeners

6. Vanes

MSF21096
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7. Connectors
8. Seams
9. And much more

Here is an example of a simple change that you may need to change;

We have insulation specifications assigned to all of our services that would require insulation,
on our Chilled Water service we have an Insulation Specification, called “Chilled Water”. | know
that this specification is not going to be the same for every project. In this case, | have it

assigned to the service, all | need to do is change my size breaks and maybe materials and |
am done...There is no need to create a new one and reassign it.

mple Profile"
[& Senvice CHWR v g i3 @ b4 EE]
Senvice Specification Not Set b
Insulation Spec |Chilled Water v
o lerances| |
_ [z Specification Chilled Water v
Servic set Rules Droplint
p Library  pipework %

<=Dim ~ Insulation Material
1.000 Fiberglass x 1
6.000 Fiberglass x 1.5
999.000 Fiberglass x 2

This would be the same scenario for any other type of specification.
We have one database administrator at each of our operating companies. Most of our database

administrators can create and setup a new Profile in about 20 minutes (Provided that they have all of
their information from the Project Manager).

MSF21096
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For REVIT, if you are planning to use Design to Fabrication (MSF21097), you can add your button
mappings needed for REVIT accessories

'FABIT AU-2016"

@, Service CHWR ~ ia o by
Service Specification Not Set v Defat
Insulation Spec | Chilled Water v Flow

Ignore Fitting Angle Tolerances| |

Service Types Button Mappings Terminals Constraints Design Entry Offset Rules

Button Code Alternate Codes
O------- Misc--------
0545 45,45

< OffsetReducer ER
RedEOLTee RedILTee
RedEOLTee RedILTee, RedInline
Red4Way PIPE, B-Assem, B-Assem, R-Assem
O------ Revit Mappings-------
Ball Valve - 2-6 Inch_2" SOV
Butterfly Valve - 2-12 Inch_6" el
[ Valve - Shut Off Standard SOV
BY Strainer - 2-20 Inch - Flanged_6" ST
L4

MSF21096
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To use the Profile in REVIT;

For a Configuration to work in REVIT the Fabrication database must have a GUID. To
determine if your database has a GUID go to “Edit the Database”

1. Click the “Configuration Tab”
2. Select the “Configuration” section
3. Click “Version”
4. |If you see a value in the “GUID” field, you should be OK
5. If you do not see a value in the “GUID” Field, click the Green button on the right and one
will be generated.

:' :‘“
= @ (= o

Configuration | Manufacturing Fittings Takeoff Costing

Confi Ii

i @ g

i Printing Draricinn.

i Company

Local Settings

i~ OpenGL Options

i-Compression Owner  User Defined ~ . I

mf;aé;;%mpts @ cuo [04GOEDC3-3EAE-46A1-0727-6E4632C0BAE3 ||l .

lgser\nter‘face Description ‘FabTeam |

i Job Status Fields

Colours Version |1

Address Book

Barcodes History

@
< User
oK Cancel

To load your Fabrication configuration in Revit
1. Click on the “System” tab
2. Click on the “Fabrication Part” button on the ribbon to open MEP Fabrication Parts pallet
3. Click “Settings”

MSF21096
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Siiiictire™| Systems

=8 0 N E

t Duct Duct  Convert to Flex Air
slder Fitting Accessory Flex Duct Duct  Terminal

HVAC 3| Fabrication 3| M
MEP Fabrication Parts X
Service:
Group:

Click Settings to select a fabrication configuration and load a
fabrication service into the model.

3

Project Browser - Project1 I Properties IMEP Fabrication Parts

1. Use the pulldown under “Fabrication Configurations”
2. Select your configuration
Fabrication Settings X

Fabrication configuration | Connection Indicators

Fabrication configurations Fabrication profiles

None . b None

None

CSUSA Config-Zold

CSUSA Config v3 @
Imperial Content V3.04

Revit MEP Imperial Content V2.0

Reload Configuration

This will take a little bit of time to load and It will default to your “Global” Profile.
Notice that if you use your global profile you may have a long list of services to choose from.

MSF21096
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Fabrication Settings

Fabrication configurati

ion | Connection Indicators

Fabrication configurations

CSUSA Config_v3
FabTeam

Fabrication services

Fabrication profiles

v Global

Unloaded services cannot be added until the configuration has been reloaded.

Unloaded services

D> Aluminum: EA
D> Aluminum: EA

(1wg)
(2wa)

D> Aluminum: OA (1wg)
D> Aluminum: OA (2wg)

D> Aluminum: RA
D> Aluminum: RA

(1wg)
(2wg)

D> Aluminum: RAMP (3wg)
D> Aluminum: SALP (1wg)
D> Aluminum: SALP (2wg)
D> Aluminum: SAMP (3wg)

D> Black Welded:
D> Black Welded:
D> Black Welded:
D> Black Welded:
D> Black Welded:
D> Black Welded:
D> Black Welded:
D> Black Welded:
D> Black Welded:

Bl Weld (10wg)
Bl Weld (-10wg)
Bl Weld (2wg)
Bl Weld (-2wg)
Bl Weld (4wg)
Bl Weld (-4wg)
Bl Weld (6wg)
Bl Weld (-6wg)
GE (2wg)

D> Double Wall: EA (2wg)
D> Galvaneal: EA (2wg)

D> Galvaneal: OA

(2wg)

D> Galvaneal: RA (2wg)
D> Galvaneal: RAMP (4wg)

D> Galvaneal: REL
D> Galvaneal: REL

(Twg)
2wg)

D> Galvaneal: SALP 2wg)

D> Galvaneal: SAMP (4wg)

D> Galvanized Weld: GALV Weld (10wg)
D> Galvanized Weld: GALV Weld (-10wg)
D> Galvanized Weld: GALV Weld (2wg)
D> Galvanized Weld: GALV Weld (-2wg)
D> Galvanized Weld: GALV Weld (4wg)
D> Galvanized Weld: GALV Weld (-4wg)
D> Galvanized Weld: GALV Weld (6wg)
D> Galvanized Weld: GALV Weld (-6wg)
N> Galvanized: FA (1wa)

<

Loaded services

Add >

<-- Remove

Learn how to set fabrication configuration and services

MSF21096
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Now select the profile that you want to use, | am using a profile that | have setup for Autodesk
University “FABIT AU-2016”. Notice that | do not have such a massive list of services because |
set up my profile for only the services needed for this project. | don’t have to pick and choose
which services | need, | will just select all of them and select “Add” when it finishes, click “OK”

Fabrication Settings

Fabrication configuration | Connection Indicators

Fabrication configurations Fabrication profiles
CSUSA Config_v3 = FABIT AU-2016
FabTeam

Fabrication services

Reload Configuration

Unloaded services cannot be added until the configuration has been reloaded.

Unloaded services Loaded services

D> Galvanized: SALP (2wg) =
D> Gak d: SAMP (dwg)

D> Galvanized: TA (2wg)

MP>CU-L-SWT (2) CS-A53-ERW-GrB-STD-BW
MP>CU-L-SWT (2) CS-A53-ERW-GrB-STD-BW
MP>CU-L-SWT (2) CS-A53-ERW-GrB-STD-BW
MP>CU-L-SWT (2) CS-A53-ERW-GrB-STD-BW. Add —>
MP>CU-L-SWT (2) C5-A53-ERW-GrB-5TD-BW.
MP>CU-L-5WT (2) C5-A53-ERW-GrB-5TD-BW.
MP>CU-L-SWT (2) C5-A53-ERW-GrB-STD-BW.
MP>CU-L-SWT (2) C5-A53-ERW-GrB-STD-BW.
MP>CU-L-SWT (2) CS-A53-ERW-GrB-STD-BW.
MP>CU-L-SWT (2) CS-A53-ERW-GrB-5TD-GRY
MP>CU-L-SWT (2) C5-A53-ERW-GrB-STD-GRY
MP>CU-L-SWT (2) CS-A53-ERW-GrB-STD-GRY
MP>CU-L-SWT (2) CS-A53-ERW-GrB-STD-GRY
MP>CU-L-SWT (2) CS-A53-ERW-GrB-STD-GRY
MP>CU-L-SWT (2) CS-A53-ERW-GrB-STD-GRY
MP>CU-L-SWT (2) CS-A53-ERW-GrB-STD-GR\
MP>CU-L-SWT (2) CS-A53-ERW-GrB-STD-GR\
P_DOM>CU-L-SWT: CD

P_DOM>CU-L-SWT: DCW
P_DOM>CU-L-SWT: DHW
P_DOM>CU-L-SWT: DHW-140
P_DOM>CU-L-SWT: DHWR
P_DOM>CU-L-SWT: DHWR-140
P_DOM>CU-L-SWT: RGW

P_DOM>CU-L-SWT: TP
P_DWV>CI-SV-Hub-Spigot (Rvt): SSBG
P_DWV:PVC-S5ch40-SW (Nibco): GW
P_DWV>PVC-S5ch40-SW (Nibco): OD
P_DWV>PVC-5ch40-SW (Nibco): SD
P_DWV>PVC-5ch40-SW (Nibco): SDBG
P_DWV>PVC-5chd0-5W (Nibco): SSAG
P_DWV>PVC-5ch40-SW (Nibco): SSBG
P_DWV>PVC-Sch40-SW (Nibco): VNT

<-- Remove

Learn how to set fabrication configuration and services
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